
 

Guía de servicios por Internet para 

empresas (BSO) para el 

Año Tributable 

2016 
 
 

 

 

 

 

 

 

 

 

 

 

FormularioW-2c por Internet 

 

 

 

Contenido de lecciones: 

 
 

 Lección 1: Crear/Reanudar formularios W-2c 

por Internet 

 Lección 2: Descargar informes ya presentados 

 Apéndice: Otras páginas 



Guía del BSO – Año Tributable 2016                                                              Formulario W-2c por Internet 

   

Administración del Seguro Social  Página 1 

LECCIÓN 1: CÓMO CREAR LOS FORMULARIOS «W-2c» O CÓMO REINGRESAR A ELLOS 

Siga las siguientes instrucciones para crear hasta cincuenta informes con veinticinco formularios «W-2c 

Online» en cada registro.  

PASO 1: En el sitio de Internet del Seguro Social, seleccione la cejilla que lee, «Empresas y  Gobierno», 

luego seleccione el enlace que lee, «Servicios para empresas». Finalmente, seleccione el 

botón que lee, «Log in or Use Business Services Online» (Ingrese o use los servicios 

por Internet para empresas) para ir a la página inicial:  

 

www.segurosocial.gov/bso/bsowelcome.htm (solo disponible en inglés). 

 

 

 

PASO 2: Seleccione el botón que lee, «Log In» (Ingrese) en la página titulada, «Business Services Online 

Welcome». El sistema mostrará la página titulada, «Log In to Online Services» (Ingrese a los 

Servicios por Internet).  

http://www.segurosocial.gov/bso/bsowelcome.htm
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PASO 3: Ingrese su «User ID» (Identificación de Usuario) y su contraseña. 

PASO 4: Seleccione el encasillado que lee, «I have read & agree to these terms» (He leído y estoy de 

acuerdo con estas condiciones) en la página titulada, «Log In to Online Services». 

Seleccione el botón que lee, «Log In» para ver la página titulada, «Main Menu». 

Para regresar a la página inicial del BSO titulada, «Welcome to Business Services Online», 

seleccione el enlace que lee, «BSO Welcome» que está en la parte superior e inferior de 

la página. 
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PASO 5: Seleccione el enlace que lee, «Report Wages to Social Security» (Informe los salarios al 

Seguro Social) en la página inicial del BSO «Main Menu». El sistema mostrará la página titulada, «Wage 

Reporting Attestation» (Confirmación de la presentación de salarios). 

 

PASO 6: Seleccione el botón que lee, «I Accept» (Acepto) en la página titulada, «Wage Reporting 

Attestation» para ir a la página inicial del EWR. 
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Para regresar a la página inicial del BSO «Main Menu», seleccione el botón que lee, «I DO NOT 

Accept» (No Acepto). 

 

PASO 7: En la página inicial del EWR: 

Seleccione la cejilla titulada, «W-2c/W-3c Online» (Formularios W-2c/W-3c por Internet). 

Luego, seleccione el enlace que lee, «Create/Resume Forms W-2c/W-3c Online» 

(Crear/Reanudar un formulario W-2c/W-3c por Internet). Si no se encuentran informes que no 

hayan sido presentados, el sistema mostrará la página que lee, «Before You Create Your Form(s) 

W-2c/W-3c» (Antes que comience a llenar sus formularios W-2c/W-3c). Si hay formularios W-

2c/W-3c que no han sido presentados, el sistema mostrará la página titulada, «Forms W-2c/W-3c 

Online Unsubmitted Reports» (Formularios W-2c/W-3c que no se han presentado).  

Puede tener un máximo de cincuenta registros de salarios que no se hayan presentado. Cuando 

haya alcanzado el máximo de cincuenta registros «guardados», se le requerirá que primero 

presente por lo menos uno de los registros guardados antes de que se le permita comenzar un 

registro nuevo. Si tiene cuarenta y nueve registros, o menos, puede continuar sin presentar los 

registros que ya existen. 
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PASO 8: En la página titulada, «Unsubmitted Reports»: 

Seleccione el botón que lee, «Start a New Report Correction» (Comience un informe nuevo). 

El sistema mostrará la página titulada, «Before You Create Your Form(s) W-2c/W-3c».  

Seleccione el enlace que lee, «Edit» o el enlace del «Employer Name» (Nombre del empleador) 

para ir a la página de «W-2c List for this Submission» (Lista de W-2c para esta presentación). 

Seleccione el enlace que lee, «Delete» para borrar un informe que no ha sido presentado. Luego 

aparecerá la página titulada, «Are you sure you want to delete the unsubmitted report?» (¿Está 

seguro que quiere borrar el informe que no ha sido presentado?).  

Seleccione el botón que lee, «Cancel» (Cancelar), para regresar a la página principal del  

EWR home. 

No podrá presentar los informes que aparezcan resaltados en rojo después del 16 de abril de 

2017 porque ya pasaron del tiempo límite para las correcciones al informe. No obstante, podrá 

revisarlos y ponerlos al día. 
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PASO 9: En la página titulada, «Before You Create Your Form(s) W-2c/W-3c»: 

  

Provea la información correspondiente al año tributable y el nombre de su empresa. Si ninguna 

de las situaciones nombradas en la sección que lee, «Check for Exception» (Verifique si existe 

alguna excepción) aplica, seleccione el botón que lee, «Continue» para ir a la página titulada, 

«Employer Information for this Wage Report Correction» (Información Empresarial para este 

informe de corrección de salarios).  

Si aplica alguna de las situaciones descritas en la sección que lee, «Check for Exception» 

(Investigue excepciones), seleccione el encasillado y el botón que lee, «Continue» para ir a la 

página titulada, «W-2c Online Restrictions» (Restricciones al Programa de W-2c por Internet).  

Seleccione el botón que lee, «Cancel», para regresar a la página inicial del EWR home.  
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PASO 10: En la página titulada, «Employer Information for this Wage Report»: 

Ingrese o revise la información de la empresa, información de la persona de contacto, cualquier 

otra información y seleccione «Kind of Payer» y «Kind of Employer» (Categoría de pagador y la 

categoría del empleador) luego seleccione el botón que lee, «Continue» para ir a la página 

titulada, «Enter W-2c Information» (Ingrese la información para el formulario W-2c).  

Seleccione el botón que lee, «Cancel» para regresar a la página inicial del EWR home. 
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PASO 11: En la página titulada, «Enter W-2c Information» (Ingrese la información para crear un 

formulario W-2c):  

Seleccione el botón que lee, «Save and Start Next W-2c» (Guardar y comenzar el próximo 

formulario W-2c) para guardar la información del formulario W-2c presente y comenzar otro. 

Es posible que el sistema muestre algunos avisos. Si el sistema muestra un aviso, puede 
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proceder, ya sea haciendo las correcciones al formulario W-2c que indica el aviso o 

seleccionando el encasillado que invalida el sobre aviso. 

Cuando termine de ingresar los formularios W-2c, seleccione el botón que lee, «Save and Go 

to W-2c List» (Guardar los formularios e ir a la lista de los formularios W-2c) para continuar 

a la página titulada, «W-2c List for this Submission» (Lista de los formularios W-2c para esta 

presentación). 

Puede ingresar hasta un máximo de veinticinco (25) formularios W-2c. El número de los W-2c 

actuales se muestra en la parte superior de la página titulada, «Enter W-2c Information». 

Cuando haya ingresado el formulario veinte cinco, el sistema ya no mostrará el botón que lee, 

«Save and Start Next W-2c». 

Seleccione el botón de «Cancel Changes» (Cancelar los cambios) para rechazar los cambios 

efectuados a este W-2c y vaya a la página titulada, « W-2c List for this Submission». 

Seleccione el botón que lee, «Delete this W-2c» (Borrar este W-2c): Si el formulario ha sido 

guardado previamente, el sistema mostrará la página que titulada, «Are you sure you want to 

delete this W-2c?» (¿Está seguro que quiere borrar este W-2c?). Si el formulario no ha sido 

guardado previamente, el sistema mostrará la página titulada, «W-2c List for Submission». 

 

PASO 12: En la página titulada, «W-2c List for this Submission»:  

Seleccione un nombre para ver y corregir la información de los formularios W-2c.  
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Seleccione el enlace que lee, «Delete» para borrar el formulario W-2c. Cuando seleccione este 

enlace, la página titulada «Are you sure you want to delete this W-2c?» aparecerá para asistirlo 

(¿Está seguro que quiere borrar este formulario W-2c?). 

Seleccione el botón que lee, «Save and Quit» para salir del formulario W-2c electrónico sin 

presentar su registro de salario al Seguro Social. Cuando seleccione este botón, aparecerá para 

ayudarlo la página titulada, «Are you sure you want to save and exit W-2c Online without 

submitting your annual wage report to SSA?» (¿Está seguro que quiere guardar los 

formularios W-2c por Internet y salir sin presentar los informes anuales de salarios al Seguro 

Social?). 

Seleccione el botón que lee, «Edit Employer Information» (Editar la información 

empresarial) para continuar a la página titulada, «Employer Information for this Wage Report 

Correction» (Información empresarial para esta corrección del informe de salarios). 

Seleccione el botón que lee, «Start a New W-2c» (Comenzar un nueva W-2c) para continuar 

a la página titulada, «Enter W-2c Information».  

 

Seleccione el botón que lee, «Continue to W-3c Preview» (Continuar a una del formulario 

W-3c) y ver la página titulada «W-3c Preview for this Submission» (Presentación preliminar 

del formulario W-3c). 
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PASO 13: En la página titulada, «W-3c Preview for this Submission»: 

 

Puede ingresar los totales de los salarios e impuestos estatales y municipales. El Seguro Social 

no utilizará esta información ni tampoco la compartirá con ningún estado o entidad local.      

                 
Seleccione el botón que lee, «Continue» para ir a la página titulada «Print Unsubmitted 

Form(s) W-2c/W-3c for Review» (Imprima los formularios W-2c/W-3c que no se han 

presentado para revisarlos). 

Seleccione el botón que lee, Return to W-2c List para regresar a la página titulada, «W-2c List 

for this Submission» (Lista de los formularios W-2c para esta presentación). 

Seleccione el botón que lee, «Save and Quit» para salir del W-2c por Internet sin presentar el 

informe de los registros salarios al Seguro Social. Cuando seleccione este botón, aparecerá 

para ayudarlo la página titulada, «Are you sure you want to save and exit W-2c Online without 

submitting your annual wage report to SSA?» (¿Está seguro que quiere guardar los 

formularios W-2c y salir sin presentar los informes anuales de salarios al Seguro Social?). 

 

PASO 14: En la página titulada, «Print Unsubmitted Form(s) W-2c/W-3c for Review»: 

Seleccione el botón que lee, «Continue» para continuar a la página titulada, «Sign and 

Submit» (Firmar y presentar el informe).   

Seleccione el botón que lee, «Return to W-2c List» (Regresar a la lista de los formularios 

W-2c) para regresar a la página titulada «W-2c List for this Submission» (Lista de los 

formularios W-2c para esta presentación). 

Seleccione el botón que lee, «Save and Quit» para salir del W-2c sin presentar la 

información al Seguro Social. Cuando seleccione este botón, aparecerá para ayudarlo la 

página titulada «Are you sure you want to save and exit W-2c Online without submitting 

your annual wage report to SSA?» (¿Está seguro que quiere guardar los formularios W-2c y 

salir sin presentar los informes anuales de salarios al Seguro Social?). 
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PASO 15: En la página titulada, «Sign and Submit»: 

Seleccione el encasillado para verificar la exactitud del informe y seleccione el botón que lee, 

«Submit This Wage Report Correction» (Presentar este informe de correcciones de los 

salarios) para presentar la corrección del registro de su salario. El sistema mostrará una página 

con una ventanilla despegable en la parte superior que lee, «Confirmation Receipt - Your File 

Was Received» (Acuse recibo - Su registro ha sido recibido). 

Seleccione el botón que lee, «Save and Quit» para guardar los W-2c y salir sin presentar la 

corrección de su registro de salario al Seguro Social. Cuando seleccione este botón, aparecerá 

para ayudarlo la página que lee, «Are you sure you want to save and exit W-2c Online without 

submitting your annual wage report to SSA?» (¿Está seguro que quiere guardar los 

formularios W-2c y salir sin presentar los informes anuales de salarios al Seguro Social?). 

Seleccione el botón que lee, «Previous» (Anterior) para regresar a la página titulada, «Print 

Unsubmitted Form(s) W-2c for Review» (Imprimir todos los formularios W-2c que no han 

sido presentados para revisarlos). 
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PASO 16: En la ventanilla despegable: 
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Seleccione el botón que lee, «OK» para imprimir la página de «Confirmation Receipt - Your 

File Was Received» (Acuse recibo – su registro fue aceptado).  

Seleccione el botón que lee, «Cancel» para cerrar la ventanilla desplegable. 

 

PASO 17: En la página de «Confirmation Receipt – Your File Was Received»: 

Seleccione el botón que lee, «Print this Page» (Imprima esta página) para imprimir la página 

de confirmación.  

Seleccione el botón que lee, «Go to Save Oficial PDF» (Guardar el documento en formato 

de .pdf oficial) para ir a la página «Save PDF» (Guardar el .pdf). 

 Su informe de salarios estará disponible para que lo revise bajo su cuenta de BSO hasta la 

fecha que se muestra en la página de su «Save PDF».  
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PASO 18: En la página titulada, «Save PDF»: 

Oprima el botón derecho del ratón de su computadora sobre el nombre del registro 

(<filename.pdf>), para ver o guardar el informe presentado. 

Seleccione el botón que lee, «Start a New Wage Report Correction» para regresar a la 

página titulada, «Before You Create Your Form(s) W-2c/W-3c» (Antes que comience a crear 

sus formularios W-2c/W-3c). 

Seleccione el botón que lee, «View Unsubmitted Reports» (Ver los Informes que no se han 

presentado) para ir a la página titulada, «Unsubmitted Reports» (Informes que no se han 

presentado). 

Seleccione el botón que lee, EWR Home para regresar a la página inicial del «EWR».   

 

LECCIÓN 2: DESCARGANDO LOS INFORMES PRESENTADOS 

Siga las siguientes instrucciones para descargar sus informes en formato de Adobe que contiene los 

formularios W-2c y W-3c para generar un informe de los formularios W-2c por Internet presentados 

durante los últimos 30 días.      

Los informes de los registros de salarios que ya han sido presentados están disponibles por 30 días o hasta 

el 31 de diciembre, lo que ocurra primero.  

PASO 1:  Seleccione el enlace que lee, «Save (or Print) Submitted W-2c Report(s)/PDF to Your 

Computer» (Guarde en su computadora [o imprima] los informes de los formularios  

W-2c/PDF presentados) que está bajo la cejilla titulada, «EWR home» de los formularios  

W-2c/W-3c Online. El sistema mostrará la página titulada, «Download Submitted Reports».  

 

PASO 2:  Oprima el botón derecho del ratón de su computadora en el enlace que lee, «WFID» 

(Identificador de los informes de salarios) en la página titulada, «Download Submitted 

Reports» (Descargar los informes presentados) para ver un menú que incluye las siguientes 

opciones:   

 Seleccione el botón de «Save Target As» (Guardar el registro bajo el nombre de…) para 

descargar el expediente a su computadora.  
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 Seleccione el botón de «Open in New Window» (Abrirlo en una nueva pantalla) para ver 

el registro. 

Se requiere el programa de computadora «Adobe Acrobat Reader» para ver el expediente de 

salarios que descargó. Si no tiene una copia de este programa de computadora, puede obtener 

una copia en www.adobe.com.  

Nota aclaratoria: Si la persona borró el informe presentado usando el procedimiento del 

«Submission Status» (Estado de la presentación), aparecerá un mensaje en pantalla haciéndole 

saber al usuario que el informe que se busca no puede ser descargado. 

Seleccione el botón que lee, «Quit» para regresar a la página inicial «EWR home». 

Seleccione el botón que lee, «Start a New Report» (Comenzar un nuevo informe) para proceder 

a la página titulada, «Before You Create Your Form(s) W-2c/W-3c» (Antes que comience a crear 

sus formularios W-2c/W-3c).  

http://www.adobe.com/


Guía del BSO – Año Tributable 2016                                                              Formulario W-2c por Internet 

   

Administración del Seguro Social  Página 18 

Apéndice: Otras páginas 

1. ¿Está seguro que quiere borrar esta página del W-2c? 

Si la persona selecciona el botón que lee, «Delete This W-2c» (Borrar este formulario W-2c) en la página 

titulada, «Enter W-2c Information» (Ingrese la información del formulario W-2c) o el enlace que lee, 

«Delete» (Borrar) en la página titulada, «W-2c List for this Submission» (Lista de los formularios W-2c 

para esta presentación) el sistema mostrará la página con la pregunta, «Are you sure you want to delete 

this W-2c?» (¿Está seguro que quiere borrar este formulario W-2c?).    

 

2. Página de restricciones del W-2c por Internet 

Los usuarios pueden tener acceso a la página titulada, «W-2c Online Restrictions» seleccionando el botón 

que lee, «Continue» en la página titulada, «Before You Create Your Form(s) W-2c/W-3c» (Antes de que 

genere sus formularios W-2c/W-3c) si selecciona el encasillado que lee, «Yes, one or more of these 

situations apply to this wage report» (Sí, una o más de estas situaciones aplican a este registro de salario). 

 

 

 

3. ¿Está seguro que quiere guardar y salir del formulario W-2c sin presentar su informe de 

registro anual de salarios al Seguro Social? 

Si la persona selecciona el botón que lee, «Save and Quit» en la página titulada, «W-2c List for this 

Submission (ABC Limited)» o en la página titulada, «W-3c Preview for this Submission» o en la página 

titulada, «Print Unsubmitted Form(s) W-2c/W-3c for Review» o en la página titulada, «Sign and Submit», 

el sistema mostrará la página con la pregunta «Are you sure you want to save and exit W-2c Online 

without submitting your annual wage report to SSA?» (¿Está seguro que quiere guardar los formularios 

W-2c y salir sin presentar los informes anuales de salarios al Seguro Social?). 
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4. La página titulada, «Are you sure you want to delete the unsubmitted report? (¿Está seguro 

que quiere borrar el informe que no ha sido presentado?)  

 

Si la persona selecciona el botón que lee, «Delete» en la página titulada, «Unsubmitted Reports», el 

sistema mostrará la página con la pregunta «Are you sure you want to delete the Unsubmitted Report?».  
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